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GLOSSARY AND LIST OF TBC AND TBD ITEMS 
CNES French National Space Agency 
TBC To Be Confirmed 
TBD To Be Defined 
GUI Graphic User Interface. Same as MMI. 
SCAO Systeme de Contrôle d'Attitude et d'Orbite 
CCD Charge Coupled Device 

 

List of TBC items: 

page 8 § 3.2.  

 

List of TBD items: 
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1. OVERVIEW 

1.1. REFERENCE DOCUMENTS 
RD1 Observation schedules preparation tool. Database Logical Design 

GMV, 18/12/0202, Issue 1, Rev. 6 
COR-511-DCB-20407-04 

RD2 Manuel d'Installation de l'application CorotSky 
CEPHIRINS Vincent, 29/06/2010, Issue 01, Rev. 12 
COR-MI-511-0001-AKKA 

1.2. APPLICABLE DOCUMENTS 
AD1 Consultation CGIS simplifiée DAJ/AR/OI N° : 2007 - 0031256 : Tierce Maintenance d'Applications 

informatiques du projet scientifique CMC COROT en exploitation 
GESSON Murielle,  ANSELLEM Franck, 23/10/2007, Issue 01, Rev. 00 
DAJ/AR/OI-2007.0031256 

AD2 Spécification Technique de Besoin du Step 3 de COROTSKY 
BOISNARD Laurent, 19/02/2007, Issue 2, Rev. 3 
COR-511-STB-1350-CNES 
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2. INTRODUCTION 

2.1. PURPOSE 
This document is the user manual of CorotSky tool. It describes all menus, dialog windows and widgets of the 
graphic user interface (GUI) and how it should be used.  

 

2.2. HOW TO USE THIS DOCUMENT 
This document has two main sections: 

 

- Overview: Users should read this section first. It gives an overview of the functionality of the tool and 
describes actions that must be performed to install the tool.  

- Interfaces: This section gives comprehensive information about all the tool capabilities. Its structure follows 
the structure of the user interface. 

 

2.3. CONVENTIONS 
Some fields of the windows and dialog windows are mandatory and others are not mandatory, for this reason, a 
convention is needed for identifying them. The convention observed in the GUI is:  

 
Fields                              Meaning 

normal                            They are mandatory. The user must enter a value. 

 

italic                               They are optional. The user can leave the field empty. 
 

The elements of the GUI in the text will appear as: 

 
Widget             

«Cancel»                        Identify an element of the GUI. 
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When a field is mandatory, it can be neither empty nor null. 

2.4. DEFINITIONS 

Extracted targets:  all stars included in the CESD satisfying a set of criteria 

Sismo potential targets:  all the stars included in the CESD for a given position of the focal plane on Sismo 
detectors. 

Exo potential targets:  all the stars included in the CESD for a given position of the focal plane on EXO detectors 
with an upper limit of the R magnitude which is a parameter. Now the initial value is fixed 
to 16 but could be changed during the lifetime of COROT. This magnitude is available in 
both catalogs: observed data and USNO extracted data. 

Candidate targets:  all stars in the focal plane (Sismo or Exo) satisfying a set of criteria 

Proposed targets: targets proposed for an observation block: list of up to 20 stars for Sismo, content of the 
Exobasket for Exo. At step 3 proposed targets will become selected targets 

Contamination level:  value with a range between 0 and 1 given by the ratio between the light flux from the star 
and the flux from the star plus the flux from the sky background. i.e. contribution of the 
background on the total flux. 0 is a very good situation without any contamination, and 
near 1 is a very bad situation 

Long Run:   continuous session of observation of 150 days on exactly the same field 

Short Run:   continuous session of observation of approximately 20 days on exactly the same field 

Mask:   assembly of adjacent pixels used to compute the photometry 

Mission Constraint   database containing the instrumental and mission parameters necessary for CorotSky and 
Database (MSDB):   described in DR1 document 

Observation block:  list of parameters defining a Long Run or a Short Run. It includes the beginning time of 
observation, its duration, the position of the CCD, the list of targets. 

Planning:   time scheduling of observations 

Project ID:   identifier of a scientific program 

Project Manager:  responsible for the validation of a candidate block for a given project ID 

Seismology:   mode of observation associated to the seismology field 

Exoplanet:   mode of observation associated to the exoplanet field 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 5 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

Sismofield:   field seen by the two seismology CCDs 

Exofield:   field seen by the two exoplanet CCDs 

Star type:  astrophysical categories of stars, as documented in the database description document 
(DR1). In particular, stars proposed for Additional Programs are given the AP type 

Dwarf:    star of luminosity class V or IV 

Giant:    star of luminosity class of III, II or I 

Step 0: initial CorotSky state. This is a common phase designed to initiate a new observation 
block or open an existing one 

Step 1: selection of sets of detectors positions: one for seismology observation and one for 
exoplanet search observation, done independently 

Step 2:   optimisation phase, taking into account the two fields 

Step 3: final phase mainly accomplished by the CorotSky planner. It includes observations 
schedule, target stars designation, observation windows programming and final CCDs 
position / rotation adjustments 

Reference position:  position of the seismology field around which the observation is built. It is either a principal 
target for Long Run or an interesting position on the sky chosen by the user for Short Run 
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3. OVERVIEW 

3.1. PROCESS TO BE SUPPORTED BY THE SOFTWARE 
The main purpose of the tool is to create the observation blocks before the satellite launch and to verify their 
feasibility taking into account all constraints of the system (instrument, satellite, platform, etc.). It provides the user 
with a graphical user interface (GUI) for achieving this task. 

The creation of an observation block is subdivided into steps. Each step completes a specific part of the full 
process. 

3.2. DESCRIPTION OF STEPS AND RELATED FUNCTIONS 
STEP 0: Selection into the whole accessible sky 

 

The main goal of this phase is to create and to initialise an observation block either for a long run (central 
program) or a short run (additional programs).  

 

This step is subdivided into several functions: 

1. Initialise and show an overall representation of the accessible region of sky. 

2. Display information on a specific star. 

3. Display the full identity card of a star. 

4. Change the asteroseismology selection criteria and redisplay the stars. 

5. List star types identifiers with the associated description. 

6. Display/erase the names of the main targets. 

7. Highlight one or more stars using the identifier or name as key search (name comes from an unspecified 
catalogue). 

8. Display a summary on extracted targets in the whole region (remember that extracted targets are those stars 
that  

satisfy the selection criteria) 

9. Save criterion of the selection. 

10. Display a specific group of targets or a combination of several groups. 

11. Undo the last operations. 
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12. Create a new observation block associated to a main target star or a position on the sky and related to one 
project. 

13. Display/erase Planet Search regions containing data (i.e. populated regions). 

14. Put the CCDs on the sky: enter CCDs coordinates or place them over a specified, visible target. 

15. Print the current selection. 

16. Use the coordinate conversion tool. 

 

 

STEP 1: Put the detectors on the sky 

 

In this phase, the user will pre-select a few positions of the CCD on the sky for each mode independently by 
optimising the first level requirements and taking into account the basic instrumental constraints.  

The user must choose the position of the CCDs, and the rotation angle. They are two working modes 
�Asteroseismology� and �Planet Search�. The two modes work separately. 

 

This step is subdivided into several sub-steps. 

Common Sub-Steps to both modes: 

1. Select the program, or working mode: �Asteroseismology� or �Planet Search�. Overplot 2 squares to 
represent the CCDs. 

2. Translate and rotate the CCDs around the star or the position. 

3. Adjust the position of the CCDs and recalculate the parameters. 

4. Display a summary on potential and candidate targets in each detector field of view separately.  

5. Undo the last operations. 

6. Save position of the detectors and expected observation period. 

7. Return to previous step. 

8. Zoom x2 and Zoom x4. 

9. Manage saved positions of the observation block (different versions). 

10. Print information on the current block. 

11. Print the current selection (display). 

12. Update the grid of positions. 
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13. Verify SCAO constraints and display the couples of stars. 

14. Display/erase the boundaries of the reachable field of sky for the exoplanet detectors.  

15. Compare two sets of selected positions using Contamination Level 0. 
 

Specific Sub-Steps of the �Asteroseismology� mode. 

 

16. Display basic information on a specific star (tooltip). 

17. Display the full identity card of a star (dialog). 

18. Change the asteroseismology selection and redisplay the stars. 

19. Display/erase the names of a group of stars. 

20. Highlight one or more stars using the identifier or name as key search (name comes from an unspecified 
catalogue). 

21. Highlight a specific selection of targets. 

22. Display polluting objects. 

23. Print candidate targets. 

 

Specific Sub-Steps of the �Planet Search� mode. 

 

24. Select catalogue. Three possibilities are available: Exoplanet catalogue, TWO_MASS catalogue or USNO 
catalogue. 

25. Overplot/erase the stars density diagram and update the number of candidates. Two possibilities are 
available: Mosaic or Contour Plot. 

26. Overplot/erase saturating objects (magnitude less than a parameter, by default 11.0) in the total reachable 
field of view around the main target star or position. 

27. Overplot/erase contamination map. 

28. Overplot/erase additional program targets. 

29. Histogram in density for 5x5 positions on each sismo detector that determines 25 regions on the field of view 
(Planet Search side). 

30. Display the density diagram in function of rotation angle. It depicts the number of candidate stars for a position 
of the detectors rotating them a step of 2.0 degrees between �20.0 and 20.0. 

31. Display the contamination map using the level 0 index of contamination (TBC). 

32. Change the planet search parameters and redisplay the current overplot. Recalculate the number of 
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candidates. 

33. Plot extracted targets histograms in function of one selection parameter. 

 

STEP 2: Selection of one position 

 

This step is subdivided into several sub-steps (these are common for both modes): 

 

All the functions defined for step 1 are also available for step 2, plus: 

 

Specific Sub-Steps of the �Asteroseismology� mode. 

 

1. Choose proposed targets for both asteroseismology detectors 

2. Create an HTML file for the proposal 

3. Create an ASCII file for the proposal 

Specific Sub-Steps of the �Planet Search� mode. 

 

4. Launch the exobasket. 

5. Fill the exobasket (add targets selections). 

6. Show the exobasket summary. 

7. Accept the selection. 

8. Save the selection. 

9. Choose the exobasket targets with time oversampling. 

10. Choose the exobasket targets with colour photometry. 

11. Print the exobasket content. 

12. Create the file for the proposed block (HTML or ASCII). 

13. Display the Contamination Map. 

 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 10 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

STEP 3: Observations schedule, targets designation and final adjustments 

 

All the functions defined for step 2 are also available for step 3, plus: 

 

1. Compute valid observations periods for each block (performed at the end of Step 2). 

2. Check valid observations periods for each block. 

3. Prepare the observations schedule using the observations periods. 

4. Calculate the pointing quaternion for each scheduled observation block. 

5. Calculate the pointing quaternion for a particular observation block. 

6. Apply small corrections to observation blocks making them valid. 

7. Create the file for the proposed block. 

 

Specific Sub-Steps of the �Asteroseismology� mode. 

 

1. Select the targets to observe for each block. 

2. Define windows around selected targets according to mission and instrument constraints. 

3. Select the SCAO couple for each block according to mission and instrument constraints. 

 

Specific Sub-Steps of the �Planet Search� mode. 

 

4. Place up to 20 sub-images (or �imagettes�) over the desired targets for each block. 
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3.3. USERS AND BLOCK RULES 

3.3.1. USERS 

There are several types of users: 

 

- CorotSky administrator. He manages CorotSky tool ( user list, parameters, etc.) through the CAT tool.  

- Planner. He performs and manages the observations planning and selects the final observation targets. 

- Scientific user. He is the standard CorotSky user. He creates the observation blocks and proposes them to 
planner. 

 

The CorotSky administrator creates a unique project and the users (Scientific user) related to it. The users� 
privileges are: 

 

 Observation 
Block creation 

Status DRAFT 

Observation Block 
candidature 

Status CANDIDATE 

Observation 
Block proposition 

Status 
PROPOSED 

Observation 
Block feasible 

Status 
FEASIBLE 

Observation 
Block planning 

Status PLANNED 

Planner X X X X X 

User X X X   

 

3.3.2. BLOCK MANAGEMENT RULES 

The status of an observation block can be: 

- DRAFT. All new blocks have this status. It is automatically set by CorotSky tool. 

- CANDIDATE. At the end of step 1, the block�s owner can change the status from �DRAFT� to �CANDIDATE�.  

- PROPOSED. At the end of step 2, if the block passes several checks, the owner can change the status from 
�CANDIDATE� to �PROPOSED�. After that, the block becomes available for the Step 3 functions, performed 
by the planner. In addition, the owner losses control over its block. 

- FEASIBLE. After selection of stars then additional checks, the planner can declare a proposed block as 
�FEASIBLE�, making it available for the scheduling phase. 

- PLANNED. All scheduled observation blocks receive automatically the �PLANNED� status. 
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4. HOW TO START COROTSKY 
CorotSky will be executed in a web browser. So, the unique requirement is to have a compatible web browser 
installed on the user�s computer, and configured for executing Java applets. 

The compatible web browsers are FireFox and Internet Explorer. The recommended web browser is FireFox 
(versions 3.0 to 3.6.8) for both Windows and Linux systems. 

The following table shows the compatibility of web browsers with JRE versions (java): 

Web browser JRE 

FireFox 3.0 to 3.5 1.4 to 1.6 

FireFox 3.6.x At least 1.6.0.15 

Internet Explorer 6 to 7 1.4 to 1.6 

For installing a JRE, you must follow the instructions of the java installation procedure (http://www.java.com). 

In order to use CorotSky with a JRE 1.4 or 1.5, it is recommended to set the maximum memory used by the 
applets to 256 Mb ; here are the instructions to set this parameter on a Windows platform : 

- Open the Windows �Control Panel�, 

- Double click the �Java plug-in� item, 

- Click the �Advanced� tab, 

- Set the following option in the �Java Runtime Parameters� field : 

-Xmx256m 

- Click �Apply� 

 

In order to use CorotSky, the user must start the web browser and type the CorotSky URL: 

 

http://smsc.cnes.fr/COROT/A_corotsky.htm 

 

and click on the COROTSKY link. 

 

How to start the web browser depends on the web browser. Mozilla FireFox 1.5.0 has been used in the examples 
of this manual. 

 

http://smsc.cnes.fr/COROT/A_corotsky.htm
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Figure 1: Starting CorotSky 

 

An identifier and password are needed. They are managed by the CorotSky administrator. 

To obtain a password send a mail to Jacqueline.platzer@obs-mid.fr and annie.baglin@obspm.fr. 

 

If the identifier or the password is not correct, the web browser will show an error message.  

 

After the user enters its identification, the web browser will show the main menu of the tool. See next section for 
further details. 

 

If the user wishes to change session (by example, to change de login name), he must close all the windows of the 
web explorer. 

 

If the user leaves a block open for 2 hours, without using the CorotSky, the connexion to the server will be lost and 
the block will be closed without being unlocked. Call the CorotSky administrator in order to unlock the block. 

mailto:Jacqueline.platzer@obs-mid.fr
mailto:annie.baglin@obspm.fr


AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 14 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

5. HOW TO USE COROTSKY 
The first window opened by the browser looks like this: 

 

Figure 2: CorotSky main frame 

There are three parts on the window: 

1- The menu bar and tool bar (on top). At the beginning, almost all menus are disabled. The menu bar gives 
access to the following submenus: 

 File 

 Edit 

 Observation 

 View 
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 CCD 

 Overplots 

 Graphics 

 Asteroseismology 

 Planet Search 

 Planner 

 Help 

 

The tool bar is composed of a set of icons and buttons: 

 Information label for the seismology program. It shows the correspondence between : 

 Star magnitude and symbol size 

 Star spectral class and symbol colour 

 Selection group and symbol shape 

 Icons giving direct access to major actions : 

 Set the CCDs. 

 Return to Step 0. 

 Asteroseismology working mode. 

 Planet Search working mode. 

 Asteroseismology CCDs map (only available for the planner) 

 Planet Search CCDs map (only available for the planner) 

 

2- The central area, where all graphics are displayed. 

3- The general information bar (or status line), at the bottom of the window. It describes the content of current 
session : 

 Current user and its role. 

 Current block�s identifier and description. 

 Current block�s status (Draft, Candidate, Proposed, Feasible or Planned). 

 Current date/time. 
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5.1. MAIN PANELS 
There are several main panels depending on the selected working mode (Asteroseismology or Planet Search) 
or the options used. In other words, when the user selects or uses some menu items the main panel will change for 
allowing the user to do other tasks.  

5.1.1. MAIN PANEL 0 

This is the first panel of the tool. 

This panel will be displayed when the user creates a new observation block or opens an existing block. 

 

Figure 3: Main Panel 0 
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The main goal of this panel is to select a main target (not mandatory) or an interesting position in the sky. Once 
the user selects a program and goes to the asteroseismology or planet search panels, the tool considers the centre 
of the asteroseismology CCDs as the position to observe (either in Short Run or Long Run). 

The panel is divided in two parts: 

- On the left side, the stars will be displayed as symbols and some other related information like scales, 
mouse position on the sky, HD numbers, etc.  

The stars are displayed using a symbol.  

 

Figure 4: Star symbol 

The meaning of the symbol is depicted by the image on the tool bar (size, colour, and group/main target). 

 

Figure 5: Star symbol description 

The size of the symbol depends on the star magnitude. The colour of symbol depends on the colour of star 
and the symbol itself depends on the group that the star belongs to. There is one exception; the main 
targets are displayed using a filled circle. If required, the star HD number can be written over the star 
symbol. 

When the user right-clicks on one star symbol, a popup menu allows him to show data of the selected star 
(option only available for stars in foreground) or show the polluting objects around it. Left-click is 
equivalent to the first menu option. See point 0 ( 

ASTEROSEISMOLOGY STARS POPUP MENU) for more details. 

The white hippodrome (or circumference) represents the observation domain within a 10º circumference. 
The hippodrome shape is due to the orbital drift. If this drift makes the hippodrome bigger than the panel, 
a horizontal scrollbar allows displace this one. 

 

- Right side. The user can choose until three groups of stars for display. Each group is depicted by a set of 
selection parameters. The parameters are permanently displayed on the panel. 
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Figure 6: Groups parameters 

To modify the parameters of a group, the user must click the �Modify� button. After that, a new dialog 
window will be opened. See "Modify group" section for further details. 

When the user has selected the parameters of a group, he can click on the �Show� button to display the 
group. 

5.1.1.1. ASTEROSEISMOLOGY STARS POPUP MENU 

When the user right-clicks on a star symbol, the following popup menu is displayed: 

 

Figure 7: Star popup menu 

The first option: �Show information� opens a dialog with the more important star�s data. 
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Figure 8: Star data 

The user will be able to obtain more data about this star. In order to do this, there are three links to the star 
databases SIMBAD, GAUDI and INES. The user must select one of them and click on the "Open link" button. 

For the GAUDI database there are three different consults: spectroscopy, photometry and physical parameters 

If the user clicks on the "More Details" button, a new dialog window will be open. This dialog window contains 
additional astrophysical information of the star (origin of data, uncertainty classes). 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 20 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

 

Figure 9: Additional details 

If the user clicks on the "Other Parameters" button, a new dialog window will be open. This dialog window 
contains additional star parameters. 

 

Figure 10: Additional star data 

The second submenu menu option "Polluting objects" shows a dialog with the polluting objects around the 
selected star. 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 21 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

 

Figure 11: Polluting objects 

Circles proportional to their magnitude, using only one colour, represent the polluting targets. 

The grey area materializes the influence of the PSF. 

A warning is shown if there are polluting objects closer then 0.9 arc minutes from the target display. 
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5.1.1.2. MODIFY A GROUP 

The user can choose the parameters that define a group of stars.  

 

Figure 12: Modifying a group 

There are several criteria or sub-set of parameters (Star type, magnitude, colour, etc.). In order to select a sub-set 
to be used, the user must select it by clicking in the checkbox that is on the left side. After clicking the checkbox, 
all the items on the panel will be available or activated. If the user clicks again on the checkbox, the items will be 
unavailable. 

The limits of some values are: 

- Magnitude. Between -2.0 and 16.0 

- Colour. Between -2.0 and 8.0 

- Subclass. Between 0 and 9 (or all values) 

- Temperature. Between 0 and 50000 

- Metallicity. Between �2.0 and 2.0 

- Vsini. Between 0 and 400 
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The other parameters are list of items selected in additional dialogs, all of them with the same operating mode. 
User can select one or more items in the list with the classical selection method: shift key for select a range of 
items and control key for select items one by one. 

 

For example, for select spectral classes we use: 

 

Figure 13: Select spectral classes (asteroseismology) 

  

For cleaning a group, the user must remove all checkboxes and click on the "Update" button. 

 

If the user clicks on the �Update� button, the parameters will be sent to the main panel and stored on the group. 

If the user clicks on the �Cancel� button, the parameters will be discarded. 

 

5.1.1.3. OPERATIONS BETWEEN GROUPS 

 

The user will be able to perform operations between the stars of groups. 

 

 

Figure 14: Operations between groups 
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There are two types of operations; AND and OR. 

 

- AND. The result is a set of stars that belong to groups at same time. 

For example: 

 

Group 1       AND     Group 2 

 

HD 0001                   HD 0004 

HD 0003                   HD 0050 

HD 0050                   HD 0003 

HD 1001 

 

Result 

 

HD 0003                   HD 0050 

HD 0050                   HD 0003 

 

- OR. The result is a set of stars that belong to one group or more groups. 

 

Group 1       OR        Group 2 

 

HD 0001                   HD 0004 

HD 0003                   HD 0050 

HD 0050                   HD 0003 

HD 1001 

 

Result 
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HD 0001 

HD 0003 

HD 0004 

HD 0050 

HD 1001 

 

When user clicks on "Apply", CorotSky performs the selected operations and displays the result on the main 
panel. 

 

Note: If the user wants to use only two groups, it is recommend that these groups were the first two ones. 
Otherwise, he may obtain undesired results. 
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5.1.2. MAIN PANEL 1 

This is the main panel of the Asteroseismology working mode. When the user selects the �Asteroseismology� 
program, the main panel will change from the Main Panel 0 to this one. Also, it will make zoom around the main 
star or position. 

 

 

Figure 15: Main panel 1. Asteroseismology working mode 

 

This panel is divided into two parts: 

 

- The right part is identical to previous panel. 
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- Left part: draw panel.  

The CCDs are depicted as four squares with their identifier on a side. For example, CCD A 2 denotes the 
Asteroseismology detector. Note that, due to the deformation geometric model, the CCDs are not perfect 
squares, and that are not perfectly aligned. In addition, any CCD can appear with only half of its standard side. 
This means that one CCD half (left or right half has been invalidated. If an entire asteroseismology CCD is 
invalidated, the application will be almost useless, because no block can achieve the proposed status. 

 

In this draw panel the user can translate and rotate the centre of CCDs. 

 

- Translate the centre.  

He must click on the left part of the panel with the mouse left button, and without releasing the button, 
drag the pointer. When he drops the button, the co-ordinates related to the button will be the new centre of 
the CCDs. 

 

- Rotate the centre. 

He must click on the left part of the panel with the mouse right button, and without releasing the button, he 
must drag the pointer. On every step, the CCDs will be redisplayed using the new rotation angle. 

 

At the top of the panel, on the right, it is permanently displayed: 

 

- Potential targets number in CCD A 2. The number of stars in the database inside second Asteroseismology 
CCD. 

- Candidate targets number in CCD A 2. The number of extracted stars inside second Asteroseismology CCD. 

 

5.1.3. MAIN PANEL 2 

This is the main panel of the Planet Search working mode. When the user selects the �Planet Search� program 
for the first time, he must select the catalogue to be used. The catalogue selection will be stored in database as 
part of the block parameters. 
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Figure 16: Entering main panel 2. Select Planet Search catalogue 

 

The USNO catalogue includes only B and R magnitude, so the selections ignore the missing parameters. All the 
functions available for step 1 and 2 can be used with the USNO catalogue except those that requires one of the 
missing parameters: 

 

 Contamination map 

 Histogram by magnitude V 

 Histogram by spectral type 

 Histogram by luminosity class 

 Histogram by contamination level 

 

Once the catalogue is selected, the main panel will change from the Main Panel 0 to Main Panel 2. Also, it will 
make zoom around the main star or position. 
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Figure 17: Main Panel 2. Planet Search working mode 

 

This panel is divided in two parts: 

 

- Left part. It displays the representation of CCDs and the overplots.  

 

- Right part. It contains the parameters for selecting stars and a short summary. 
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Figure 18: Planet Search parameters 

 

There are several criteria or sub-set of parameters (Magnitude B, V, I, R, Star Type, Spectral Type, etc.). In order 
to select a sub-set to be used, the user must select it by clicking in the checkbox that is on the left side. After 
clicking the checkbox, all the items on the panel will be available or activated. If the user clicks again on the 
checkbox, the items will be unavailable. 
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The limits of some values are: 

 

- Magnitude B, V, I, R. Between 12.0 and 16.0 

- Contamination level. Between 0.0 and 1.0 

- Cell Size. Between five (5) and thirty (30) arc minutes. 

 

The other parameters are list of items selected in additional dialogs, all of them with the same operating mode. 
User can select one or more items in the list with the classical selection method: shift key to select a range of 
items and control key to select items one by one. 

 

For example, to select spectral classes we use: 

 

 

Figure 19: Select spectral classes (planet search) 

 

For cleaning the selection, the user must remove all checkboxes and click on the "Accept" button. 

 

If the user clicks on the �Accept� button, the parameters will be sent to the main panel and stored on the block. 

If the user clicks on the �Cancel� button, the parameters will be discarded. 

 

Also, this part contains a short summary on potential targets split by CCD . Fields: 
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- Total number. The number of stars in database within the planet search detectors (potential targets). 

- Giants. The number of potential targets with luminosity equal to 'I', 'II' or 'III'. 

- Dwarfs. The number of potential targets with luminosity equal to 'IV' or 'V'. 

- Contaminated. The number of potential targets with a contamination level greater than a threshold (between 
brackets). 

 

The summary must be updated manually (pressing button �Update�) When the CCDs are moved or the target 
selection parameters are modified, the summary becomes outdated. This fact is highlighted with two warning 
marks. 

5.1.4. MAIN PANEL 3 

This main panel offers a representation of the Asteroseismology detectors. Each CCD is represented as a non-
rotated, perfect square. This means that the geometric model and the CCDs rotation are not directly represented. 
However, they are reflected in the stars coordinates on screen, obtained by invoking the MGPV (modèle 
géométrique de prise de vue) program provided by the CNES. 

 

The CCDs are shown with two different scales: 

 

 1:6 scale, that allows full view of both detectors 

 1:1 full scale, in which 1 CCD pixel corresponds to 1 screen pixel 

 

There are two functions only available at full scale: show pixels cosmetics (highlight pixels defects) and reference 
photometric masks. 
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Figure 20: Main panel 3. Asteroseismology CCDs map (1:6 scale) 
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Figure 21: Main panel 3. Asteroseismology CCDs map (1:1 scale) 

 

The panel is divided in two parts: 

 

- Left part. It displays the representation of the CCDs and the objects they contain: 

 

 Proposed stars, with their priority. Represented as in previous panels. 

 Observation windows (each one placed over the selected star it observes). Represented by a red 
rectangle. 

 Mirror windows (placed symmetrically to each observation window). Represented by an orange rectangle. 

 SCAO couples Represented as a light grey line between the couple members. The selected couple for 
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each block is represented by a thicker, white line. 

 

- Right part. It contains all other controls required at this application point: 

 

 List of selected target stars. It can be used to discard an already selected target by selecting a star and 
pressing �Discard�. It can also be used to discard all already selected targets by pressing �Discard All�. 

 Lists of available SCAO couples (one list per CCD). One couple can be selected per list. The selected 
couple is highlighted in the draw panel and the corresponding observations windows are created. 

 Visual field controls. These six buttons allow small displacement and rotations of the visual field (i.e. the 
CCDs). The increments  by default are: 

o 1 CCD pixel for translations, 0.000635 degrees approximately 

o 0.02 degrees for rotations. This is an arbitrary increment, comparable to the 1 pixel translations 

 Additional controls, including: 

o Full scale: this button changes the CCDs view between 1:6 and full scale 

o Star names: this button shows/hides the star�s names 

o Cosmetics: this button shows/hides pixels cosmetics (i.e. defects). Only for full-scale view. 

 Dark pixels are painted in orange 

 Bright pixels are painted in green 

o SCAO pairs: this button shows/hides the lines that signal the SCAO couples. 

o R. P. masks: this button shows/hides reference photometric masks around the stars. Only for full-
scale view. 

o Resolution: this button changes the default increments values  

o Save all: this button saves the current state of the selection. It is only enabled when there are non-
saved changes. 

 Create File: this button creates the list of targets in ASCII file. It is only enabled when changes are saved 
and the SCAO constraint has satisfied. 

5.1.4.1. SISMO PROPOSED STARS EXTENDED POPUP MENU 

When the user right-clicks on a star symbol, the following popup menu is displayed: 
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Figure 22: Extended popup menu 

 

The first option, �Select star�, designs this star as a selected target, and the corresponding observation window is 
created. The following dialog allows configure its location and size: 

 

 

Figure 23: Observation window configuration 

 

This dialog is also shown when the user clicks over an already created window, allowing reconfigure it. 

 

The second submenu option, "Brilliant parasites", shows a dialog containing the parasite stars with V magnitude 
< 12.0 around the selected star. The shown area has a 16 arc minutes side. 
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Figure 24: Brilliant parasite stars 

 

The two last options are similar to the standard popup menu options, described in 0. 

5.1.5. MAIN PANEL 4 

This main panel offers a representation of the Planet search detectors. As in the asteroseismology panel, each 
CCD is represented as a non-rotated, perfect square. This means that the geometric model and the CCDs rotation 
are not directly represented. However, they are reflected in the stars coordinates on screen, obtained by invoking 
the MGPV (modèle géométrique de prise de vue) program provided by the CNES. 

 

The CCDs are shown with two different scales: 

 

 1:6 scale, that allows full view of both detectors 
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 1:1 full scale, in which 1 CCD pixel corresponds to 1 screen pixel 

 

There are one function only available at full scale: show pixels cosmetics (highlight pixels defects). 

 

Figure 25: Main panel 4. Planet search CCDs map (1:6 scale) 
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Figure 26: Main panel 4. Planet search CCDs map (1:1 scale) 

 

The panel is divided in two parts: 

 

- Left part. It displays the representation of the CCDs and the objects they contain: 

 

 Proposed stars. Represented individually as circles following the sismo stars conventions. 

 Observation images (or �imagettes�) placed over the desired star. Represented by a white rectangle of 
fixed size (15x10 pixels). 

 

- Right part. It contains all other controls required at this application point: 
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 Lists of observation images (one list per CCD). It can be used to discard an already placed image by 
selecting a row and pressing �Discard�. 

o  

 Additional controls, including: 

o Full scale: this button changes the CCDs view between 1:6 and full scale 

o Cosmetics: this button shows/hides pixels cosmetics (i.e. defects). Only for full-scale view. 

 Dark pixels are painted in green 

 Quantum efficiency pixels are painted in orange  

o Save all: this button saves the current state of the selection. It is only enabled when there are non-
saved changes. 

o Create File: this button creates the list of targets in ASCII file. 

 

The observation images are placed by pressing the �Place� button of the proper images list (the list decides the 
target CCD). This action shows the following dialog, which allows configure the image location (remember that the 
size is fixed as 15x10 pixels): 

 

 

Figure 27: Observation image configuration 
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5.2. THE COROTSKY MENU 
The following ten chapters are dedicated to each of the submenus that compose the CorotSky menu: 

 File 

 Edit 

 Observation 

 View 

 CCD 

 Overplots 

 Graphics 

 Asteroseismology 

 Planet Search 

 Planner 

 Help 

The menu options are enabled or disabled depending on the current step of the application. In addition, there are 
several menu options only visible for the planner. 
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6. MENU FILE 
This menu contains the general options for printing and exiting from CorotSky. 

Three print options are included: 

 Block information: prints block parameters and global results. 

 Current selection: prints the selection criteria and the stars selected with them. 

 Candidate targets: prints the asteroseismology candidate targets list. 

 

Figure 28: File menu 

6.1. PRINT BLOCK INFORMATION 
This option is only available for Step 1 and later. It prints general information about the currently opened 
observation block, including: 

 The block header, with the identifier and name,  user, current date, last update, program, direction, main 
target (if any), catalog (if any) and the CCDs position and rotation 

 Main star position in the CCDs grid as well as the value of angle 

 HR diagram (with calculated ranges; see point 0 for more details) 

 Stars distribution histograms by magnitude V, vsini, adopted metallicity and star type 

6.2. PRINT CURRENT SELECTION 
This option is only available for Step 1 and later. It prints an overview of the extracted targets, with a different 
content depending on the current step and working mode. 

For the asteroseismology mode, the page includes: 

 The same block header used in 0 

 Selection parameters for each group 

 Currently visible sky region (whole sky for Step 0 or a part for Step 1) 

 Summary of potential and proposed targets 

 HR diagram (only for Step 1 and later) 
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For planet search mode, the page includes: 

 The same block header used in 0 

 Exoplanet selection parameters 

 Currently visible sky region (including shown overplots) 

 Summary of potential and proposed targets 

6.3. PRINT CANDIDATE TARGETS 
This option prints an overview of the asteroseismology candidate targets. 

The page includes: 

 List of candidate targets including: identifier, name, magnitude v, spectral type, luminosity class, absolute 
magnitude, temperature, vsini, metallicity and gravity 

 HR diagram 

 A map of the sismo CCD. 

This option is not available for planet search mode. 

6.4. QUIT 
This option terminates the CorotSky tool. If there is a block opened, it is saved (with confirmation from the user) 
and closed. 
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7. MENU EDIT 
This menu contains the typical options for cutting, copying and/or pasting objects and undo changes. 

 

 

Figure 29: Edit menu 

 

They work as expected, whenever user must type characters. For example, if the user presses control key (Ctrl) 
plus C key, the object, which the key is pressed on, will be copied into memory. After, if the user presses the 
control key (Ctrl) plus V key over other object, the content of the memory will be copied into the target edit box. 

 

The undo option is less straightforward; it undoes the last operations one by one (there is not a limit for the number 
of queued operations). But only a subset of all options allowed in the tool can be undone. This subset is composed 
by the following operations: 

 

 Edit block 

 Modify planet search selection parameters 

 Modify selection group 

 Set bad regions 

 Set CCDs position 

 Adjust CCDs position 

 Propose targets 

 

When the user changes the visible panel, the list of operations queued for undo is reset, in order to avoid 
incompatibilities. 
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8. MENU OBSERVATION 
This menu contains all options needed for handling an observation and its versions. 

  

Figure 30: Observation menu 

8.1. CREATE A NEW OBSERVATION 
This window enables the user to create a new observation block. An observation block is related to one or several 
projects. 

 

Figure 31: Create new observation 
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Field description: 

- Description. It contains the description of the observation block. The reason why the user wants to make this 
observation. 

- Mode. This combobox contains two values; Asteroseismology and Planet Search.  

- Program. This combobox contains two values; Long run and Short run.  

- Obs num. This combobox contains ten values; [�00�..�10�] 

- Centre or Anticentre. The user can select the zone of the sky to be observed. When the user selects a value, 
the table presents the main targets for the selected direction, only for information purpose. If the user has 
chosen long run program, he has to put the CCDs around one of these targets. For a short run, any position is 
acceptable (see menu CCD). 

For creating the block, the user must click on the �Create� button. After that, the main panel of the tool will change. 
See �Main Panel 0� section for further details. 

If he wants to discard the block and not to create the block, he must click on the �Cancel� button. 

8.2. OPEN AN EXISTING OBSERVATION BLOCK 
The user can open existing observation blocks via this option.  

 

Figure 32: Open an observation 

The list contains the list of all previously saved blocks which belong to the user. It displays several information on 
each block in order to help the user to choose one of them. 

The user selects the block and its version by clicking on the corresponding line of the list. After that, he must click 
on the �Select� button to continue. 

If the user clicks on the �Cancel� button, no observation block will be selected and opened. 
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Note that it can be blocks with �INVALIDATED� status. A block is marked as invalidated when a modification in the 
CCDs geometry (realized by the CorotSky administrator) makes a block inoperative. The three invalidation causes 
are: 

 The main target is not inside of an asteroseismology CCD. 

 No stars couple satisfy the SCAO constraints for one (or both) asteroseismology CCD. 

 There are not enough asteroseismology proposed targets for one (or both) asteroseismology CCD. 

The user can open their invalidated blocks, but he cannot operate with them. The following message informs 
about this fact and demands confirmation: 

 

Figure 33: Opening an invalidated observation 

8.3. EDIT 

8.3.1. EDIT OBSERVATION PARAMETERS 

This option enables the user to modify the parameters of the current observation block and to update them. 

 

Figure 34: Edit observation parameters 
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Fields description : 

- Owner. The user cannot edit this field. It is person who has created the block. He must belong to the list of 
authorised users for the corresponding project. 

- Block identifier. The user cannot edit this field. 

- Description. As proposed by the block�s owner. 

- Version. Block version number. The user cannot edit this field. 

- Version description. As proposed by the block�s owner. 

- Creation date. The user cannot edit this field. Its format is: �dd/MM/yyyy� 

dd   � day 

MM  � month 

yyyy � year 

 

- Last update. The user cannot edit this field. Its format is: �yyyy-MM-dd HH:mm:ss� (the format used by the 
database) 

yyyy � year 

MM  � month 

dd     � day 

HH   � hours 

mm   � minutes 

ss   � seconds 

 

- Block status. The possible values are Invalidated, Draft, Candidate, Proposed, Feasible and Planned. The 
only selectable values are Draft, Candidate and Proposed. All others are assigned in different functions across 
the application. As explained before, the pass to Proposed block is a very special case, because after that, the 
block becomes available for the Step 3 functions, performed by the planner. In addition, the owner losses 
control over its block. 

 

If the user clicks on the �Update� button, all changes made in the block will be saved. If the user clicks on the 
�Cancel� button, the changes will be discarded. The changes will remain in the memory until the user save the 
block. 

If the user clicks on the �Edit parameters� button, a new dialog window will be open where the user will be able to 
edit a set of advanced block parameters. See next section for further details. 
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8.3.2. EDIT OBSERVATION PARAMETERS. ADVANCED 

In this dialog window, the user can consult the most import parameters of the observation block and update part of 
them. 

 

Figure 35: Edit observation parameters (Advanced) 

 

Fields description: 

- Direction. They are two possible values: Centre or Anticentre. The user cannot edit this field. 

- Program. They are two possible values: Long run or Short run. The user cannot edit this field. 

- Mode. They are two possible values: Asteroseismology and Planet Search. 

- CCDs position. The user cannot edit this fields 

 Right ascension. Right ascension of the centre of CCDs. Format: �HH:MM:SS� 

HH   � hours 

MM  � minutes 

SS     � seconds 
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 Declination. Declination of the centre of CCDs. Format: �DD.MM.SS� 

DD   � degrees 

MM  � minutes 

SS     � seconds 

 Rotation. Rotation angle of the CCDs (in decimal degrees). 

 Roll ; Roll angle of the CCDs (in decimal degrees). 

- Star / Position. The user cannot edit this fields 

 Corot ID. Star identifier of the main target if the block is for a Long Run program. 

 Right Ascension. Right ascension of the star, which is main target, or position in the sky. 

 Declination. Right ascension of the star, which is main target, or position in the sky. 

 Rotation bounds. Maximum and minimum rotation angle allowed for this block version (by default �20º 
and +20º). These angles are only informative; they do not represent a real constraint. 

When the user clicks on the �Close� button, the changes will be saved internally in the observation block and the 
dialog window will be closed. 

If the user clicks on the �Cancel� button, the changes will be discarded and the dialog window will be closed. 

8.3.3. SKIP AN OBSERVATION BLOCK TO FEASIBLE STATE 

This option is only available to the planner.  

 

Figure 36: Skip to Feasible 

When the user clicks on the �OK� button, the status observation block will be changed  and saved as �Feasible� for 
planning. 

No checks must be performed (for example SCAO). 

If the user clicks on the �Cancel� button, the changes will be discarded and the dialog window will be closed. 

Be careful, this function can be used immediately after set CCD position, it gives access to quarternion calculation 

or to scheduling block, but some stars may not be selected in this block.. 
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8.4. SAVE THE CURRENT OBSERVATION 
This option saves the current observation block.  

 

 

Figure 37: Save observation 

 

The parameters of the block will remain in the memory until the user saves the block. He can choose between 
saving the block using the current version "Save the current block", creating a new block �Save as new block� 
or creating a new version "Save as new version". This option will create a new block and/or new version and the 
current block or version will remain without changes. Remark: the option �Save as new block� will not be proposed 
in Step 3. 

 

When the user clicks on the �Save� button, the changes will be saved on the database and the dialog window will 
be closed. 

If the user clicks on the �Cancel� button, the changes will be discarded and the dialog window will be closed. 
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8.5. DELETE OBSERVATION BLOCK 
The user can delete observation blocks or versions of an observation block. 

 

 

Figure 38: Delete an observation 

At first time, the list will contain all the observation blocks that belong to the user. In order to delete a block, the user must 
select the block in the list and click on the �Delete� button. After that, the tool will ask for a confirmation before deleting the 
block. 

 

Figure 39: Confirm delete 

If the user clicks on the �Yes� button the observation block will be deleted, otherwise the block or block version will 
not be deleted. 

8.6. CLOSE THE CURRENT OBSERVATION 
When the user ends its work, he must close the observation block. If he has not saved the last changes of the 
block, the tool will ask the user to do it. If the user has saved all changes, the tool will not ask for saving the block, 
it only will close the block. 
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Figure 40: Save observation 

If the user clicks on the �Save� button, the tool will ask the user to save the block. See "Save the current 
observation" for further details. Otherwise, it will not be saved. 

If the user clicks on the �Cancel� button, the changes will be discarded and the dialog window will be closed. 

After closing the observation, the Main Panel 0 will be removed. In its place, an empty panel will be displayed. 

8.7. DELETE A VERSION OF THE CURRENT OBSERVATION 
This option enables the user to delete a version of the current observation block, but only one. For deleting more 
than one version see section �Manage versions�. 

 

 

Figure 41: Delete observation version 

At first time, the list will be fulfilled with all versions of the block. The user will be able to delete only the versions 
he has created. For deleting a version, first, he must select a line in the list and then click on the �Delete� button. 

Field description : 

- Block identifier. Identifier of the current observation block. The user cannot modify this field (see 0). 

- Description. Description of the current observation block. The user cannot modify this field. 

- List. It contains all versions of the block, one line for each version.  
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If the user clicks on the �Delete� button the selected observation block version, the tool will ask for a confirmation.  

 

Figure 42: Confirm delete observation version 

If the user clicks on the �Cancel� button, no block version will be deleted and the dialog window will be closed. 

8.8. SELECT PROGRAM 
After the block has been created, the user must select the working mode. They are two modes; Asteroseismology 
or Planet Search. The set of available options in the menus depends on the working mode. 

  

 

Figure 43: Select program 

 

The main panel will change depending on the program. If the user selects the Asteroseismology program the new 
panel will be the Main Panel 1, see �Main Panel 1� for further information. Otherwise, the new panel will be the 
Main Panel 2, see �Main Panel 2� for further information. 

 

The application�s tool bar offers shortcuts for these two very common operations. 
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9. MENU VIEW 
This menu contains the options for modifying the way the data are displayed. All data will be displayed in the 
current panel.  

 

 

Figure 44: View Menu 

 

The options View star names => View group, View boundaries and Hide Scale are only available starting from 
step 1 (Asteroseismology or Planet Search working mode). 

9.1. ZOOM X2 
Opens a new window where it will display a zoom using linear scales multiplied by two. The zoomed field centre 
coincides with the centre of the CCDs. 
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Figure 45: Zoom x2 

 

Additional options are available in this dialog. Show SCAO bounds and SCAO windows are used for graphically 
check the SCAO constraints. The zoomed panel can also be printed, including the block header and the toolbar 
legend. 
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9.2. ZOOM X4 
It opens a new window where it will display a zoom using linear scales multiplied by four. The zoomed field centre 
coincides with the centre of the CCDs. 

  

Figure 46: Zoom x4 

Additional options are available in this dialog. Show SCAO bounds and SCAO windows are used for graphically 
check the SCAO constraints. The zoomed panel can also be printed, including the block header and the toolbar 
legend. 
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9.3. FIND STARS 
This function allows the user to localize one or more stars in the current panel. He can use the COROT identifier 
or any other identifier from other star catalogues. 

 

The tool will look for the star in the current set of selected stars. If it is found, the star will be highlighted by 
surrounding it with a white circle. Also, the HD number will be displayed. 

 

 

Figure 47: Star found 

 

If the star is not shown in the current panel, it will be searched in the catalogues, and if it is found in them, a 
message containing the position of the star will be displayed. 

 

 

Figure 48: Star not found 

 

The search is case-insensitive, and all blanks are ignored. 
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The �Erase� button removes the highlighting circles and HD numbers of the found stars. If the dialog is closed 
without pressing the erase button, the stars will remain highlighted until the user changes the current panel, or 
press erase in a later stars finding session. 

9.4. GLOBAL SUMMARY 
The summary is a report on the different sets of targets, depending on the current application step and working 
mode: potential targets, extracted targets and candidate targets. 

 

The asteroseismology summary for the Step 0 informs only about extracted targets: 

 

Figure 49: Hole sky asteroseismology summary 

 

The asteroseismology summary for the Step 1 or later informs about potential and candidate targets: 
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Figure 50: Asteroseismology summary 
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The asteroseismology summary for each target set has three parts: 

 

 The total number of stars (per CCD in step 1 or later). 

 Histograms. The user can obtain a histogram of magnitude, vsini (V * sin(i)  = Rotation velocity), 
metallicity, temperature or star types. 

 The number of stars by spectral class. It is displayed in the list. 

 HR diagram (only for candidate targets) 

 

 

 

Figure 51: Histogram example (stars/MV) 

 

The HR diagram is a 2-dimensions graphic with: 

 X-axis: log10 Teff decreasing to the right, where Teff is the �adopted effective temperature� 

 Y-axis: absolute magnitude Mv decreasing to the top 
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The maximum and minimum values can be fixed (the default option): 

 In abscissa the definition range is [4.5, 3.5] 

 In ordinate the definition range is [-1, +6] 

 

Or automatically computed for the display (the second option): 

 In abscissa from max (log10 Teff + 0.02 and min (log10 Teff) - 0.02 

 In ordinate from max (Mv) + 0.5 and min (Mv) - 0.5 

 

In addition, two fixed straight lines representing ZAMS (in bold) and TAMS (in fine) must be drawn, defined by 2 
points: 

 ZAMS: (Mv = 4.4; log10 Teff = 3.78  ) and (Mv = 2.3; log10 Teff = 3.99  ) 

 TAMS: (Mv = 4.4; log10 Teff = 3.695) and (Mv = 2.3; log10 Teff = 3.785) 

The targets are represented by squares proportional to m_v (apparent visual magnitude) and using one colour per 
observation block (when more than one block is showed in the diagram).  

If the value of the parallax is greater than 3, the square is filled. If the value of the parallax is less than 3 or 
unknown the squares is empty. 

Finally, the ZAMS line has plotted two additional points representing the position of 1M0 and 2M0 at Mv = 5.1 and 
Mv = 1.8. 
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Figure 52: HR diagram 

The planet search summary for the Step 1 or later informs only about candidate targets: 
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Figure 53: Planet search summary 

The summary contains: 

 Total number of candidate targets on each detector  

 Histogram : Repartition of candidate stars by range of magnitude R 

 Tables with the repartition by spectral type / range of magnitude or luminosity class of candidates in witch 
CCD 

 Or tables with the repartition by luminosity class / range of magnitude or spectral type of candidates in 
witch CCD 

 

All three summaries and the HR diagram are floating dialogs and can remain open while the user performs other 
tasks. Changes in the CCDs position or stars selections are automatically reflected in the opened summaries. The 
opened floating dialogs are closed on user request or when the current main panel is changed. 
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9.5. VIEW POPULATED REGIONS 
Shows the regions of the sky where there are data in the Exoplanet (LAM) star catalogue. The regions will be 
displayed in a graphical way. 

 

Figure 54: Populated Regions 

When the user moves the mouse pointer over a populated region a text will be displayed with the number of stars 
in the region for each catalog. 

After selecting this option, the View menu will change and will look like this: 

 

Figure 55: Populated regions 
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For hiding the regions the user must select another time this option in the menu.  

9.6. VIEW STAR NAMES 
Displays the star names of the main targets or a group of stars. 

 

Figure 56: View star names for main targets 

After selecting this option, the View menu will change and will look like this: 
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Figure 57: Hide star names for main targets 

For hiding the star names the user must select another time this option in the menu. 

9.7. VIEW BOUNDARIES 
Displays the boundaries of the area where the user can translate or rotate the CCDs. The boundaries will be 
aproximated as a N-side polygon. 
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Figure 58: Boundaries 

After selecting this option, the View menu will change and will look like this: 

 

Figure 59: Hide boundaries 
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For hiding the boundaries the user must select another time this option in the menu. 

9.8. VIEW SCALE 
This option is active by default. It displays a scale alongside the borders of the sky by displaying tick marks with 
associated values. The steps are respectively: 

 5� on alpha axe and   1° on delta axe in standard mode 

 2� on alpha axe and 30� on delta axe in zoom x2 mode 

 1� on alpha axe and 15� on delta axe in zoom x4 mode 

The scale is shown in the step 1 and step 2 panels and in the zoom windows. 

9.9. SHOW STAR TYPES 
This option lists the asteroseismology star types identifiers with the associated description. The values are 
provided by the asteroseismology database. 

 

Figure 60: Star types list 

9.10. CONVERSION TOOL 
This option accesses the coordinates conversion tool: 

 

Figure 61: Coordinates conversion tool 
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9.11. COMPUTE OMEGA EPHEMERIS 
This option accesses the compute omega ephemeris window: 

 

Figure 62: Compute Omega ephemeris 
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10. MENU CCD 
This menu enables the user to handle CCDs, their position and orientation. 

 

 

Figure 63: CCD menu 

 

The option "Set position" is only available in step 0. The other options are available in step 1 (Asteroseismology 
or Planet Search working mode). 

10.1. SET POSITION 
This option enables the user to select the position of the centre of the CCDs. 

 

 

Figure 64: Set CCDs position 
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At first time, it displays the current position of the CCDs centre (right ascension and declination) and the rotation 
angle. They are displayed in the �Right Ascension�, �Declination� and �Rotation Angle� fields of the �Position 
on the centre of the focal plane� panel. 

 

The user can choose the new position in two ways: 

 

 By writing the new position in the �Right Ascension� and �Declination� fields of the �Star positioned at 
the centre of the CCD A2� panel. If the user clicks on the �Apply� button, which is on the right of these 
two fields, the CCDs will be translated letting the new position in the centre of the CCDA2. These two 
values will be displayed in the �Right Ascension� and �Declination� fields of the �Current position� 
panel. The coordinates format is previously shown in the fields: right ascension format is �HH:MM:SS�, 
and declination format is �DD.MM.SS�, where 

DD   � degrees 

HH   � hours 

MM  � minutes 

SS     � seconds 

 By selecting a star as the reference for CCDs position. First, the user must choose the type of star 
identifier he wants to use. He must select the �HD number� or �COROT ID� checkbox and after that, he 
must enter the star identifier in the text field, which is on the right of the select checkbox. The selected star 
search is case-insensitive, and all blanks are ignored. 

If the user clicks on the �Apply� button, which is on the right of the text fields, the CCDs will be translated 
letting the star coordinates in the centre of the CCDA1. The new position will be displayed in the �Right 
Ascension� and �Declination� fields of the �Position on the centre of the focal plane� panel. 

 

The user can choose the new rotation angle of CCDs by writing the new rotation angle in the �Rotation� field of 
the Star positioned at the centre of the CCD A2 panel. 

 

If the user clicks on the �Close� button, the two values stored in the �Right Ascension� and �Declination� fields of 
the �Position on the centre of the focal plane� panel will be the new centre of the CCDs. 

If the user clicks on the �Cancel� button, all changes will be discarded. 

10.2. ADJUST POSITION 
After choosing the position of the centre of CCDs, the user can make fine adjustment of the position. He can 
translate or rotate the centre of CCDs very softly. 
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Figure 65: Adjust CCDs position 

At first time, the dialog displays the current position of the centre; right ascension, declination and the rotation 
angle of the CCDs. They are displayed in the �Right Ascension�, �Declination� and �Rotation Angle� fields of 
the �Current position� panel. 

The user can use the �Rotation� panel to rotate the CCDs. When the user moves the �Angle� slider, the increment 
to apply to the rotation angle will change in accordance with the slider position. The resolution determines the 
effect of the slider movements: lesser values allow softer rotations. When the user clicks on the �Apply� button, 
the increment value is added to the current CCDs rotation. This is reflected in the �Rotation Angle� text field of 
the �Current position� panel. 

The default value of the resolution is 0.001 degrees. It will be displayed in the �Resolution� text field. The user will 
be able to change the resolution by entering a new value in the text field.  

The user can use the �Translation� panel to displace the CCDs. When the user moves one slider, the 
corresponding value will be changed in accordance with the slider movement. If the user clicks on the �Apply� 
button of this panel, it will read the text fields and the values will be written in the corresponding fields of the 
�Current position� panel. 

The default value of the resolution is 0.001 degree. It will be displayed in the �Resolution� text field. The user will 
be able to change the resolution by entering a new value in the text field. 

If the user clicks on the �Close� button, the values stored in the fields �Right Ascension�, �Declination�, and 
�Rotation Angle� of the �Current position� panel will be read and they will become the new orientation of CCDs. 

If the user clicks on the �Cancel� button, all changes will be discarded. 
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10.3. SET BAD REGION 
This option enables the user to select a region the CCD as bad. Also, he will be able to unselect a region as bad.  

 

Figure 66: Set a bad region 

 

A region is a small square in one of the two Asteroseismology CCDs. Each Asteroseismology CCD will be divided 
into twenty-five (25) regions. A region can be considered as bad if: 

 

- SCAO. When the main target is into this region, the SCAO constraints are not fulfilled. 

- Asteroseismology. It is not a good region for the Asteroseismolgy scientific program. Maybe, the region does 
not fulfil the scientific objectives. 

- Planet Search. It is not a good region for the Planet Search scientific program. Maybe, the region does not 
fulfil the scientific objectives. 

 

The current position of the main target will be displayed in a graphical way over the corresponding region. 

 

When the user clicks on a region, the row and column number will be displayed in "Row" and "Column" fields. 
After that, he can set the reason. There are several types (Normal, SCAO, Asteroseismology, and Planet Search).  

 

If the user clicks on the �Apply� button, the regions will be stored and the dialog window will be closed. 

If the user clicks on the �Cancel� button, all changes will be discarded. 
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11. MENU OVERPLOTS 
This menu contains the options for plotting several types of graphics into the current panel. 

  

Figure 67: Menu Overplots 

11.1. DENSITY OF STARS 
The density of stars can be plotted as a mosaic or as contour line.  

Density of stars as a mosaic: 

 

Figure 68: Density of stars as mosaic 
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The density of stars is computed using the set of selected stars. The set of stars is read from the database using 
the selection parameters displayed on the right side of the panel. These parameters are described in the section -.  

The sky region is split into small squared cells. Each cell is coloured according the number of stars in that small 
region. The colour is taken from the number of stars and a scale displayed on the left side of the panel. The scale 
is relative, as it is defined by the minimum and maximum number of stars in a cell. 

Density of stars as a contour line: 

 

Figure 69: Stars density as contour line 
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11.2. SATURATING OBJECTS 
This function overplots an individual representation of the stars with magnitude less than 11.0 (a parameter). The 
stars are represented by circle proportional to their magnitude, all in light grey. 

The scale defines 3 levels: 

 Magnitude from 0.0 to 8.0 

 Magnitude from 8.0 to 9.5 

 Magnitude from 9.5 to 11.0 

 

Figure 70: Saturating objects overplot 
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11.3. CONTAMINATION MAP 
It plots a representation of the contamination level as a grey scale map. This map of density is represented in 
mosaic mode with a 5� cell dimension. Each cell gives the percentage of stars with a level of contamination level 
lower than a value (threshold) that the user can change. By default this value is 0.1. The threshold can be changed 
using the �Select the contamination map threshold� dialog: 

 

Figure 71: Select contamination map threshold dialog 

After this, the contamination map must be redrawn to apply the new value. The change is not stored in database; it 
takes effect only during the current CorotSky session. 

 

Figure 72: Contamination map overplot 
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11.4. OVERPLOT ADDITIONAL PROGRAM TARGETS 
This function plots individual A.P. objects selected by criteria in the total reachable field of view around the main 
target or position. It uses as input the A.P. EXO. catalog used only for this function and the exoplanet zooms. 

 

Figure 73: A.P. targets overplot 

The A.P. symbols have the following behaviours: 

 Moving the mouse over a symbol shows the A.P. identifier and name for the star. 

 Left clicking over a symbol shows all parameters of the star: 
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Figure 74: A.P. star data 

The Additional Program targets selection parameters to be used for Overplot A.P. targets are: 

 magnitude V 

 magnitude B  (disabled by the moment; this field must be included in database) 

 magnitude R  (disabled by the moment; this field must be included in database) 

 star types: multi selection in a list of predefined types. 

These parameters are not stored between sessions. 

 

Figure 75: A.P. targets selection parameters 

11.5. CLEAR OVERPLOTS 
Remove all previously displayed overplots. This option enables the user to come back to a clean panel. 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 81 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

12. MENU GRAPHICS 
This menu contains the options for plotting several types of histograms and graphics in a dialog. 

 

 

 

Figure 76: Menu Graphics 

12.1. VIEW SCAO 
This option displays a list of star couples in each Asteroseismology CCD that fulfill the SCAO constraints. 

 

 

Figure 77: View SCAO 
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There are two lists, one for each Asteroseismology CCD. Each line of the lists contains a couple of stars and the 
distance between the stars, measured in pixels. Fields: 

 

- Corot Id A. First star Corot identifier. 

- Name A. First star usual name 

- Magnitude A. First star magnitude. 

- Corot Id B. Second star Corot identifier. 

- Name B. Second star usual name 

- Magnitude B. Second star magnitude. 

- Distance. Distance between star A and star B in pixels. 

- Remarks. If distance is bigger than the minimum SCAO distance, but lower than the standard one, we mark 
this couple as "Difficult" so this couple satisfies all SCAO constraints. 

 

SCAO constraints: 

 

The list of stars couples satisfying SCAO constraints is built with the potentials stars and the parameters coming 
from the DBC.(CAT) 

 

- The magnitude of SCAO stars must be less or equal to 8.5. 

- At least, there must be a couple of SCAO stars for each asteroseismology CCD. 

- Minimal distance between stars must be five hundred (500) pixels. 

- The distance from the SCAO stars to the edges of CCDs must be greater than seventy-five (75) pixels. 

- The distance from the SCAO stars to the central column of CCDs must be greater than seventy-five (75) 
pixels. 
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12.2. VIEW DENSITY HISTOGRAM 
This option helps to characterize the exoplanet field for the different possible positions of the sismo main target. 

 

 

Figure 78: Density histogram 

 

In order to compute the histogram, the selected asteroseismology CCD is split into 25 cells. We have the following 
values for each position of the main target in a given cell of one CCD: 

- The total number of EXO targets in E 2. 

- The minimum star number per square degree. 

- The maximum star number per square degree. 

The CCDs grid representation placed on the right, shows graphically the cells which not achieve the threshold 
assigned for the stars number (6.000 by default) 
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12.3. VIEW DENSITY & ROTATION ANGLE 
This option displays the stars number & rotation angle histogram. 

 

Figure 79: Density & rotation angle. 
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12.4. VIEW TARGETS DISTRIBUTION 
This option shows histograms with a distribution of the extracted exoplanet targets in the CCDs by different 
criteria: 

 Magnitude B 

 Magnitude V 

 Magnitude R 

 Spectral type 

 Luminosity 

 Contamination level 

All histograms have the same look: all are vertical bars diagrams. So we show here only the Spectral type as an 
example: 

  

Figure 80: Spectral type targets distribution. 
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12.5. THERMICS 
This option displays in a new window the temperature according to the direction of the observation (centre or 
anticentre), the day, the roll and the delta. These two last parameters can be set by two sliders. 

A menu can be displayed upon a right-click on the window. This menu enables the user to: 

- change the properties of the window like the color of the axis (�Properties...�) 

- print the thermic graph (�Print...�) 

- zoom in, zoom out (�Zoom In�, �Zoom Out�) 

- resize the axis of the window (�Auto Range�) so that all the temperature values are displayed 

The zoom in and the auto-range can also be performed by maintaining, respectively, the left and right click of the 
mouse.  

Two bars next to the sliders indicate the reliable delta and roll values. The green color refers to the reliable values 
and the red color to the unreliable ones. 

Hereafter we show an example of the window: 
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This function is based on data of the file sortie_ete.csv, which is read when the direction of the observation is 
centre, and the file sortie_hiver.csv which is read when the direction of the observation is anticentre ; theses files 
are located in the /internet/COROTSKY/server_root/data directory on the web server ; these files have the 
following format : 

- The first line defines the trust zone of the �delta� values : <min_value>;<max_value> 

- The second line defines the trust zone of the �roll� values : <min_value>;<max_value> 

- One block of 81 lines and 41 columns (�;� is the separator of columns) represents temperature data of a period 
of 5 days for different values of delta (columns) : 

 

 

 Col. 1 : 
delta=-10 

Col. 2 : 
delta=-9,5 

� � Col. 40 : 
delta=9,5 

Col. 41 : 
delta=10 

Row 1 : 

Roll=-20 

T° for 
delta=-10 
and roll=-
20 

�     

Row 2 : 

Roll=-
19,5 

� �     

�       

�       

�       

�       

�       

Row 80 : 

Roll=19,5 

    � � 

Row 81 : 

Roll=20 

    � T° for 
delta=10 
and 
roll=20 

 

 

There are 40 periods in total in a csv file (200 days). 

 

 

 

 

 

Period i of 5 
days 

Period i-1 of 
5 days 

� 

Period i+1 of 
5 days 

� 
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13. MENU ASTEROSEISMOLOGY 
This menu contains the options for the Step 2 processes in the Asteroseismology program. 

 

 

Figure 81: Menu Asteroseismology 

13.1. PROPOSE TARGETS 
This option allows users to select between 6 and 10 candidate targets per asteroseismology CCD. The selected 
stars become proposed targets. 

 

 

Figure 82: Propose targets 

All candidate stars are shown in the CCDs representation. With a mouse click, the user can select each star as a 
proposed target. CorotSky will check that no more than 10 stars are proposed for this CCD. 

The proposed stars are identified in the CCDs with a number that represents its priority, and are added to the 
proper table on the right side. 
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The user can change the priority and remove the star in the table using the priority column combo box. 

The white lines between stars indicate the SCAO couples. They can be hidden with the SCAO check box. 

13.2. PROPOSAL DOCUMENT 

13.2.1. An HTML document 

This option prepares and shows an HTML document in a new navigator window with a summary of the proposed 
targets. Then, the users can print or save the generated document (temporally stored in the server). 

 

 

 

Figure 83: Proposed targets document (HTML) 

The summary includes: 

 A header describing the observation block 
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 The position of the CCDs (coordinates and angle) 

 List of proposed targets: Corot ID (CID), HD number if exists (HD), magnitude V (mv), spectral type, 
log(Teff) (effective temperature), Mv (absolute magnitude), Vsini, parallax,Star Type if exists and 
enlighten targets OK for SCAO.  

 The HR diagram 

 A map of the two asteroseismology CCDs. 

13.2.2. An ASCII document 

This option prepares and shows document in ASCII in a new navigator window with a summary of the proposed 
targets. Then, the users can print or save the generated document  

 

Figure 84: Proposed targets document (ASCII) 

The summary includes: 

A header describing the observation block 

 The position of the CCDs (coordinates and angle) 

 List of proposed targets: Corot ID (CID), usual name (HD number or others), magnitude V (mv), , spectral 
type, log(Teff) (effective temperature), Mv (absolute magnitude), Vsini, parallax; Star Type if exists and 
enlighten targets OK for SCAO.  
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14. MENU PLANET SEARCH 
This menu contains the options for the Step 2 or step 3 processes in the planet search program. 

 

 

Figure 85: Menu planet search 

14.1. PROPOSE TARGETS : THE EXOBASKET 
This option launches the �exobasket�, a sub-application intended to propose the planet search targets. This tool is 
relatively independent and its use will be described in detail as separated application. Before starting, the user is 
requested for save the current block, given that this is required for the exobasket to work properly.Finally, the user 
shall choose the catalog of stars. The Exobasket will be created with this catalog. 

It is possible to use the Main Panel with the active exobasket window. 

The exobasket contains sets of planet search candidate targets, extracted from database through different 
selection processes. Each selection creates a subset of candidate targets, according to scientific criteria peculiar 
to the exoplanet program and/or to additional ones. The windowing priority depends on the selection orders..  

To fill the exobasket one has first to built subsets and then decide whether the subset is included in the exobasket or 
not. When the user is satisfied, it accepts and save the content and all the targets inside the basket will become 
proposed targets in the current observation block. Once the exobasket is filled, user has to proceed to the selection 
of exobasket targets for colour photometry in a way quite similar to the one used for fill the exobasket. This last 
operation ends Step 2. 

The exobasket frame contains the following components: 

 A menu bar that contains all available functions. As the CorotSky menu, the menu items are enabled or 
disabled depending on the selection current state. The main menu contains the following sub-menus : 

o Selection 

o Colour photometry 

o Graphics 

 A table that summarizes the current selection. The summary is structured as follows (from top to bottom) : 

o Zero or more rows, each one representing a targets subset (an exobasket selection) 

o One row with the total exobasket targets selection 
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o Zero or more rows, each one representing a colour photometry targets selection 

o One row with the total targets selected for colour photometry 

 

Each row contains: 

o An identifier 

o The selection criteria used (only for rows that represents selections) 

o Targets number for each CCD 

o Dwarfs number for each CCD 

o Binaries number for each CCD 

o Additional program targets number for each CCD 

 

 

Figure 86: The exobasket frame 
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14.1.1. MENU SELECTION 

This menu allows managing the exobasket selection, adding and deleting targets subsets. 

 

Figure 87: Menu selection 

14.1.1.1. ADD INDIVIDUAL TARGETS 

14.1.1.1.1. Item �Individual targets� 

This option allows users to select targets individually around a given position within the detectors. The position 
must be specified as its coordinates (á, ä; in J2000) of as a given star (when user press �Apply� the star�s 
coordinates are shown). When used the closed button see the paragraph Choose individual targets 

 

Figure 88: Choose selection zone 
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14.1.1.1.2. Item �Additional program star� 

This option allows users to select targets individually around a given position within the detectors. The position 
must be specified as a given Additional Program star. When used the Apply button see the paragraph Choose 
individual targets 

 

14.1.1.1.3. Choose individual targets 

If all the stars potentials does not exist around the position given or were already selected by one preceding 
selector, an error message is posted. 

Else, the tool shows all potential targets surrounding the position within a given distance (radius). Then, the user 
can select /unselect target with the mouse�s left button (a red cross will mark a target as selected). The right button 
shows the target�s information dialog. Only one target can be selected. 

It is possible to interoperate with the CorotSky main window while using these two dialogs. However, several 
operations are restricted in order to maintain the coherence with the exobasket content: 

 CCDs translation / rotation 

 Those included in these submenus: 

 File 

 Edit 

 Observation 

 CCD 

 Asteroseismology 

 Planet search 

The most interesting use of this feature is the possibility of showing exoplanet maps, change the selection, show 
the zoomed views and show the planet search summary. 
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Figure 89: Choose individual targets 
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14.1.1.2. ADD FILTERED TARGETS 

This option allows users to select a subset of targets according with a combination of selection parameters, in the 
same way as described in section -. The parameters involved are: 

 Magnitude B, V and R (min and max values) 

 Star type: (list of values)  

 Spectral type: 

o Spectral class (O, B, A, F, G, K, M; list of values) 

o Subclass (min and max values or all values) 

 Luminosity class (I, II, III, IV, V; list of values) 

 Contamination level (values ranging from 0 to 1) 

 

 

Figure 90: Choose selection parameters 
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14.1.1.3. CHANGE PRIORITY 

This option change the priority of the selection currently highlighted in the summary table. If no selection is 
highlighted, the option is disabled. 

No confirmation is requested. 

14.1.1.4. DELETE SELECTION 

This option removes the selection currently highlighted in the summary table. If no selection is highlighted, the 
option is disabled. 

No confirmation is requested. 

14.1.1.5. DELETE ALL SELECTIONS 

This option removes all the exobasket selections.  

No confirmation is requested. 

14.1.1.6. SHOW SELECTION CRITERIA 

This option shows the criteria used to create the selection currently highlighted in the summary table. If no 
selection is highlighted, the option is disabled. 

For selections performed by parameters, a dialog quite similar to the one used for enter the parameters is shown 
with the parameters values. 

 

Figure 91: Show selection parameters 
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For individual selections, another dialog with the coordinates and the selected targets identifiers is shown: 

 

Figure 92: Individually selected targets 

14.1.1.7. PROPOSE SELECTION 

This option implies the acceptance of the current exobasket content. A warning will be shown if exobasket targets 
list is not greater than a configurable threshold (6000 by default) per CCD. Once accepted, these targets become 
proposed targets, and no more selections can be added or deleted in the exobasket. In addition, the colour 
photometry menu is enabled and can be used. 

14.1.1.8. SAVE SELECTION 

This option saves the current exobasket session. 

14.1.1.9. CLOSE SELECTION 

This option ends the current exobasket session. It requests the user to save data when necessary. 

This event prepares document in ASCII with a summary of the discarted targets by the MGPV Program 

 

Figure 93: Discarted targets document (ASCII) 

The summary includes : 

A header describing the observation block 

 List of discarted targets: Corot ID and coordinates (RA and Declination).  
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14.1.1.10. PRINT SELECTION 

This option prints the current exobasket content, including : 

 The block header, with the identifier and name, project, user, current date, last update, program, direction, 
main target (if any) and the CCDs position and rotation. 

 The summary of the current selection. 

14.1.1.11. SAVE SELECTION AS HTML DOCUMENT 

This option creates and opens in a new navigator window an HTML document describing the current exobasket 
content, including: 

 The block header described in previous point. 

 The summary of the current selection. 

 A histogram with the number of dwarf stars per bin of magnitude. 

 A histogram with the number of giant stars per bin of magnitude. 

 

Figure 94: Exobasket summary document (HTML) 

14.1.1.12. SAVE SELECTION IN ASCII FORMAT 

This option creates and opens in a new navigator window a document in ASCII describing the current exobasket 
content (a summary of the proposed targets), including: 

 The block header described in previous point. 

 The position of the CCDs (coordinates and rotation) 

 The catalogue (EXO, TWO_MASS or USNO) 
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 The name and the number of targets by CCD, 

List of proposed targets: Priority, (number of selection), Corot ID (CID), usual name (HD number or others), 
magnitude V (mv), magnitude R (mr), spectral type, contamination (c0), type (star type 1 and type 2 if exist), 
chrom/mochrom 

 

Figure 95: Exobasket summary document (ASCII) 
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14.1.2. MENU COLOUR PHOTOMETRY 

This menu allows managing the exobasket targets subsets selected for colour photometry. It is not possible to 
assign an exobasket selection to a new colour photometry selection. 

 

Figure 96: Colour photometry menu 

14.1.2.1. SELECT TARGETS INDIVIDUALLY 

This option allows users to individually select targets from the exobasket content around a given position within the 
detectors. This function is identical to the function 0 and will not be described. 

14.1.2.2. SELECT TARGETS BY PARAMETERS 

This option allows users to select from the exobasket content a subset of targets for colour photometry, according 
with a combination of selection parameters, in the same way as described in section -. The parameters involved 
are: 

 

 Magnitude B, V and R (min and max values) 

 Spectral type: 

o Spectral class (O, B, A, F, G, K, M; list of values) 

o Subclass (min and max values or all values) 

 Luminosity class (I, II, III, IV, V; list of values) 

 Contamination level (values ranging from 0 to 1) 

 Binarity (yes or not) 

 



AKKA IS COR-MU-511-0001-AKKA 

TMA CMC COROT Issue : 04 Date  : 29/06/2010 

 Rev. : 03 Date  : 25/01/2011 
Reference :   Page : 102 

 

\\Srv-projet1\projets\CNES\COROT_TMA\03_Base_Documentaire\02_Documentation_Livrable\01_Travail\Lot1_CorotSky\COR-MU-511-0001-AKKA_V4.3_User_Manual_CorotSky.doc - 24/01/11 16:01 

 

Figure 97: Choose selection parameters for colour photometry 

14.1.2.3. DELETE ALL 

This option removes all colour photometry targets selections.  

No confirmation is requested. 

14.1.3. MENU GRAPHICS 

This menu allows plotting as histograms several aspects of the exobasket content. 
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Figure 98: Graphics menu 

Five different plots are available: 

 Number of dwarf stars per bin of magnitude. 

 Number of giant stars per bin of magnitude. 

 Number of dwarf stars per bin of contamination. 

 Number of giant stars per bin of contamination. 

 Number of binaries with a dwarf member per bin of magnitude. 

All of them have the same look so we will only show one as example: dwarf targets number distributed by 
contamination level. 

 

Figure 99: Dwarfs distribution by contamination 
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14.2. SELECT CATALOGUE 
This option displays the �Select catalogue for planet search� window. If the Exobasket is not in the �Proposed� 
state, this dialog window allows to select the Exo, Two mass or the USNO catalogue. If an Exobasket already 
exists, it will be deleted. 

 

Figure 100: �Select Catalogue for planet search� window 
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15. MENU PLANNER 
This menu contains the options specific for the planner. Even though there are options visible for everybody, the 
non-planner users have only read access to them. 

 

Figure 101: Menu planner 

15.1. VIEW PARASITE LIGHT 
This option is only available for main panel 0. It shows two additional hippodromes (or circumferences) that 
represent the observation domain within 7º and 15º circumferences. These radiuses are parameters. Remember 
that the hippodrome shape is due to the orbital drift. 

 

Figure 102: Parasite light hippodromes 
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15.2. OBSERVATION PERIODS 
This option allows the planner to check the feasibility date of an observation block by showing all its possible 
periods (with solar constraints). 

 

 

Figure 103: Observation periods 

 

The user can choose the observation ellipses and its intersection lens for each observation period. This allows him 
to ensure the feasibility of a particular block. The procedure is simple: select a period (table cell) and press the 
button �Show�. It can show up to three ellipses, as Worst Case, Reference and Optimal. 

 

 

Figure 104: Show observation ellipses / lens for a period 
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This opens a new dialog box showing the main targets in the selected block�s direction and the desired observation 
ellipses (in white). 

Despite the following representations shows the Corot�s eye as an ellipse, they can be set by the CorotSky 
administrator as the ellipses semi-large/semi-small axes represent the parasites light isofluxes , to reflect the 
differences between the north/south and east/west directions. 

 

 

Figure 105: Observation circles without orbital drift 

 

If the orbital drift is significant for the selected period, the observation ellipses are split into two sets, one 
representing the Corot�s eye at the beginning and the other one at the end of the period. The non-intersecting zone 
(coloured in cyan) represents a non-valid observation region, because the stray light constrains are not respected 
over the entire period. 
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Figure 106: Observation ellipses with significant orbital drift 
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15.3. SCHEDULE OBSERVATION: OPEN SCENARIO 
This option allows the planer to open an existing observation plan (or schedule). A list of observation schedule is 
proposed; the planer can select an observation schedule and remove or open this.  

 If the planer removes the scenario, this scenario is lost and disappears of the list. 

 If the planer opens the scenario, he can modify this scenario: see following paragraphs. 

Note: Since version 5.9 of COROTSKY the planner has been modified. Then scenarios created before this version 
are already opened in last version editor of planner (see SCHEDULE OBSERVATIONS: OPEN OLD SCENARIO) 
and scenarios created since version 5.9 are opened with new editor of planner. 

15.4. SCHEDULE OBSERVATIONS: OPEN OLD SCENARIO 
This option allows the planner to modify an old observations plan (or schedule) in a graphical way, using the 
available observation periods. Note that only blocks already designed as feasible can be scheduled. 

The mission is split into observation lapses, alternating centre and anticentre directions and long and short runs. 
The objective is to provide an observation block for each time lapse, and decide the observation change date 
when overlaps occur. Additionally, long and short runs can be interchanged, as we will see. 

 

Figure 107: Modify observation schedule scenario 
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We describe now the process step by step: 

 

15.4.1. DECIDE PROGRAMS PRECEDENCE 

The user can select the programs precedence for each half-year period. These periods are separated by vertical 
lines and identified in the top of the schedule as �direction� + �year�. The default sequence for a year is LR � SR � 
SR � LR (LR for Long Run and SR for Short Run). To switch programs the user must press the switch button, 
represented as two cycling arrows: 

 

  

Figure 108: Switch programs button 

 

15.4.2. POPULATE AN OBSERVATION LAPSE 

The user must select an empty observation lapse (represented as a blue rectangle). This actions highlight the 
rectangle and displays the list of observation blocks available for populated it: 
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Figure 109: Selecting an observation block (1) 

Now the user can select the desired block in the table. This action shows the aiming suggestions that should help 
him to choose the better position within the period (at the beginning or at the end): 

Figure 110: Aiming suggestions 

 CENTRE DIRECTION (SUMMER): 

- Negative distance to null roll angle BLOCK BEST AT PERIOD'S BEGIN 

- Positive distance to null roll angle BLOCK BEST AT PERIOD'S END 

ANTICENTRE DIRECTION (WINTER): 

- Positive distance to null roll angle BLOCK BEST AT PERIOD'S BEGIN 

- Negative distance to null roll angle BLOCK BEST AT PERIOD'S END 
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The �Select� button is also enabled, allowing user to complete the process. 

 

Figure 111: Selecting an observation block (2) 

Once selected, the block passes to fill the time lapse. The (almost arbitrary) begin and end dates of the empty 
period are replaced by begin and end dates of the observation period provided by the selected block. These dates 
are marked with dashed lines. 

 

In a scenario under construction, a block can be scheduled only once. When the user tries to use it in a different 
place of the plan, it its removed from its previous position, but only after confirmation from the user. However, the 
same block can be found in different scenarios. 

 

 

Figure 112: Scheduling an already used block 
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Note also that the �Remove� button has been enabled, allowing user to undo the selection. 

 

 

Figure 113: Selecting an observation block (3) 

 

15.4.3. SEPARATION DATE BETWEEN PERIODS 

When two consecutive observation periods overlaps in time, the user must decide the cutting date. This can be 
done by displacing the slider bar that appears in these situations: 

  

Figure 114: Limit date between periods 

By definition, this operation always takes place when deciding the limit between the long and short runs of the 
same half-year period. But it is also common between observations of different periods (i.e. different directions). 
However, the treatment is similar. 
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15.4.4. LUNAR�S CONSTRAINTS PERIODS 

Lunar�s constraints periods can be displayed for an observation block by the mouseover of column �Lunar constr.� 
when the value is �yes�. 

 

15.5. SCHEDULE OBSERVATIONS: NEW SCENARIO 
This option allows the planner to create a new observations plan (or schedule) in a graphical way, using the 
available observation periods. Note that only blocks already designed as feasible can be scheduled. 

The mission is split into 3 observation lapses by periods, alternating centre and anticentre directions. The objective 
is to provide an observation block for each time lapse, and decide the observation change date when overlaps 
occur. 
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Figure 115: New observation schedule scenario 

We describe now the process step by step: 

 

15.5.1. DECIDE PROGRAMS PRECEDENCE 

The user can select the programs precedence for each half-year period. These periods are separated by vertical 
lines and identified in the top of the schedule as �direction� + �year�. The default sequence for a year is 3 runs by 
period. 

 

15.5.2. POPULATE AN OBSERVATION LAPSE 
The user must select an empty observation lapse (represented as a blue rectangle). This action highlights the 
rectangle and displays the list of observation blocks available for populating it: 
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Figure 116: Selecting an observation block (1) 

Now the user can select the desired block in the table. This action shows the aiming suggestions that should help 
him to choose the better position within the period (at the beginning or at the end): 

 

 

 

 

 

 

 

 

 

Figure 117: Aiming suggestions 

The �Select� button is also enabled, allowing user to complete the process. 

 CENTRE DIRECTION (SUMMER): 

- Negative distance to null roll angle BLOCK BEST AT PERIOD'S BEGIN 

- Positive distance to null roll angle BLOCK BEST AT PERIOD'S END 

ANTICENTRE DIRECTION (WINTER): 

- Positive distance to null roll angle BLOCK BEST AT PERIOD'S BEGIN 

- Negative distance to null roll angle BLOCK BEST AT PERIOD'S END 
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Figure 118: Selecting an observation block (2) 

Once selected, the block passes to fill the time lapse. The (almost arbitrary) begin and end dates of the empty 
period are replaced by begin and end dates of the observation period provided by the selected block. These dates 
are marked with dashed lines. 

 

In a scenario under construction, a block can be scheduled only once. When the user tries to use it in a different 
place of the plan, it is removed from its previous position, but only after confirmation from the user. However, the 
same block can be found in different scenarios. 

 

 

Figure 119: Scheduling an already used block 
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Note also that the �Remove� button has been enabled, allowing user to undo the selection. 

 

 

Figure 120: Selecting an observation block (3) 

 

15.5.3. SEPARATION DATE BETWEEN PERIODS 

When two consecutive observation periods overlap in time, the user must decide the cutting date. This can be 
done by displacing the slider bar that appears in these situations: 
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Figure 121: Limit date between periods 

By definition, this operation always takes place when deciding the limit between runs of the same half-year period. 
But it is also common between observations of different periods (i.e. different directions). However, the treatment 
is similar. 

15.5.4. LUNAR�S CONSTRAINTS PERIODS 

Lunar�s constraints periods can be displayed for an observation block by the mouseover of column �Lunar constr.� 
when the value is �yes�. 
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15.5.5. ADDITIONAL CONTROLS 

Those three steps, repeated for each period, configure an observation plan. We describe now the remaining 
controls: 

15.5.5.1. QUATERNION 

There two types of quaternion, the aiming quaternion and the waiting quaternion. 

 

Figure 122: Select Type Quaternion 

This choice is proposed only on a block put in the first period (SR or LR, in function operator choice). 
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15.5.5.1.1. AIMING QUATERNION 

The �Aiming Quaternion� check box shows in a new navigator window the aiming quaternion for the currently 
selected observation period, following the format required by the PGGS (Proteus Generic Ground Segment). 

 

Figure 123: Aiming quaternion 

15.5.5.1.2. WAITING QUATERNION 

The �Waiting Quaternion� check box shows in a new navigator window the waiting quaternion for the currently 
selected observation period, following the format required by the PGGS (Proteus Generic Ground Segment). 

 

Figure 124: Waiting quaternion 

15.5.5.2. SCHEDULE DESCRIPTION 

The text area at the bottom of the dialog allows user to write comments about the current schedule. The 
description is limited to 200 characters. 

15.5.5.3. PRINT SCHEDULE 

The �Print� button allows printing the currently visible portion of the schedule. No additional information is 
included. 

15.5.5.4. SAVE SCHEDULE 

The �Save� button is only available for the planner. All other users can consult and operate existing schedules but 
never overwrite them. The button remains disabled while there are not unsaved modifications. When saving a 
schedule, all blocks planned for the first time receive the �PLANNED� status, and the corresponding aiming 
quaternion is calculated and stored in database as part of the block�s definition. 
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15.6. SCHEDULE OBSERVATIONS: OPEN SCENARIO 
This option allows the planner to continue working on a previous observations plan (or schedule). All other users 
can use this function to consult the planner�s work but without writing permissions. 

 

Figure 125: Open an existing schedule 

15.7. LINE OF SIGHT 
This option allows to show, at any moment in the session: 

- the line of sight, for a particular observation block (as requested), (for reminder, the quaternion computed with 
biais angles for an observation block ) 

- and the coordinates on the sky of the four corners of each CCD (Right Ascension, Declination). 

 

 

Figure 126: Line of sight 
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15.8. VIEW LOG FILE 
This option allows to show the log file of Corot server. 

It describes the filename with location path and displays content in text field. 
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ANNEX A MATRIX  STEP / FUNCTION � MENU OPTION 

STEP 0 

Sub 
step 

Description Menu option 

1 Initialise and show an overall 
representation of the accessible region of 
sky. 

Observation => New 

Observation => Open 

2 Display information on a specific star. In the main panel, the user must place the mouse 
pointer over a star. 

3 Display the full identity card of a star. In the main panel, the user must click on a star with 
the mouse left button. 

4 Change the asteroseismology selection 
and redisplay the stars. 

In the main panel, the user will be able to change 
the parameters relate to each group. 

5 List star types identifiers with the 
associated description 

View => Show star types 

6 Display/erase the HD name of the main 
targets. 

View => View star names => Main targets 

7 Identify and show a star using its name as 
key search (name comes from an 
unspecified catalogue). 

View => Find star 

8 Display a summary on selected targets in 
the whole region. 

View => Summary 

9 Save criterion of the selection. Observation => Save 

Observation => Save as new block 

Observation => New as new version 

10 Highlight a specific selection of targets. In the main panel, the user will be able to select the 
group of stars to be displayed. 

11 Undo the last operations. Edit => Undo 

12 Create a new observation block 
associated to a selected main target star 
or a position on the sky and related to one 
or several projects. 

Observation => New 

Observation => Open 

13 Display/erase Planet Search regions 
containing data. 

View => View regions 

14 Put the CCDs on the sky. CCD => Set position 

Button in tool bar. 

15 Print the current selection. File => Print => Current selection 

16 Use a coordinate conversion tool. 

 

View => View conversion tool 
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STEP 1. COMMON FUNCTIONS 

Sub 
step 

Description Menu option 

1 Select the working mode; 
�Asteroseismology� or �Planet Search�. 
Overplot 4 squares to represent the 
CCDs. Verify SCAO constraints for all 
positions on the grid. 

Observation => Select program 

Graphics => View SCAO 

2 Translate and rotate the CCDs around the 
star or the position and, recalculate the 
parameters. 

In the main panel, the user will be able to translate 
the centre of CCDs by using drag & drop with 
mouse left button and to rotate the centre by using 
drag & drop with mouse right button.  

3 Adjust the position of the CCDs and 
recalculate the parameters. 

CCD => Adjust position 

4 Display a summary on potential selected 
targets in each field of view of the 
detectors separately. 

It will be displayed in the main panel at bottom.  

5 Undo the last operations. Edit => Undo 

6 Save position of the detectors and 
expected observation period. 

Observation => Save=> Current version 

Observation => Save=> As new block 

Observation => Save=> As new version 

7 Return to previous step. Button in tool bar. 

8 Zoom x2 and Zoom x4. View => Zoom x2 

View => Zoom x4 

9 Handle saved positions of the observation 
block. 

Observation => Manage versions 

10 Print information on the current block. File => Print => Block information 

11 Print the current selection (display). File => Print => Current selection 

12 Update the grid of positions.  

13 Verify SCAO constraints and display two 
couples of stars. 

Graphics => View SCAO 

14 Display/erase the boundaries of the 
reachable field of sky. 

View => View boundaries 

15 Compare two sets of selected positions. Observation => Compare versions 
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STEP 1. ASTEROSEISMOLOGY MODE 

Sub 
step 

Description Menu option 

16 Display information on a specific star. In the main panel, the user must place the mouse 
pointer over a star. 

17 Display the full identity card of a star. In the main panel, the user must click on a star with 
the mouse left button. 

18 Change the asteroseismology selection 
and redisplay the stars. 

In the main panel, the user will be able to change 
the parameters relate to each group. 

19 Display /erase the HD name of a group of 
stars. 

View => View star names => View group 

20 Identify and show a star using its name as 
key search (name comes from an 
unspecified catalogue). 

View => Find star 

21 Highlight a specific selection of targets. In the main panel, the user will be able to select the 
group of stars to be displayed. 

22 Display polluting objects. In the main panel, the user must click on a star with 
the mouse right button and select Polluting objects 

23 Print candidate targets. File => Print => Candidate targets 
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STEP 1. PLANET SEARCH MODE 

Sub 
step 

Description Menu option 

24 Select catalogue (regular exoplanet, Two 
mass or USNO) 

Selection dialog shown the first time user enters in 
planet search mode. 

25 Overplot/erase the stars density diagram 
and update the number of candidates. 

Overplots => Density stars => Mosaic 

Overplots => Density stars => Contour 

26 Overplot/erase saturating objects 
(magnitude less than 11) in the total 
reachable field of view around the main 
target star or position. 

Overplots => Saturating objects 

27 Overplot/erase contamination map. Overplots => Contamination map => View 
mosaic 

Overplots => Contamination map => Select 
threshold 

28 Overplot/erase additional program 
targets. 

Overplots => Additional program => View 
targets 

Overplots => Additional program => Select 
parameters 

29 Histogram in density for 5x5 positions on 
each sismo detector that determines 25 
regions on the field of view (Planet 
Search side). Display in a new window. 

Graphics => View histogram 

30 Display the density diagram, which is 
function of rotation angle. It depicts the 
number of candidate stars for a position 
of the main target star with a step of 2 o 
between �20 o and 20 o. 

Graphics => Density & rotation angle 

31 Display the contamination map using the 
level 0 index of contamination. 

Graphics => Contamination 

 

32 Change the planet search parameters and 
redisplay. Recalculate the number of 
candidates. 

In the main panel, the user will be able to select the 
new parameters. 

33 Plot several histograms Graphics => View targets distribution => By � 
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STEP 2. COMMON FUNCTIONS 

Same functions as Step 1. 

 

STEP 2. ASTEROSEISMOLOGY MODE 

Same functions as in Step 1 

Sub 
step 

Description Menu option 

1 Choose proposed targets for both 
asteroseismology detectors 

Asteroseismology => Propose targets 

2 Create an HTML file for the proposal Asteroseismology => Proposal document => TO 
HTML 

 

STEP 2. PLANET SEARCH MODE 

Same functions as in Step 1 

Sub 
step 

Description Menu option 

3 Launch the exobasket. Planet search => Propose targets 

4 Fill the exobasket (add targets 
selections). 

In exobasket menu: Selection => Add 

5 Show the exobasket summary. Always showed in the exobasket sub-application 

6 Accept the selection. In exobasket menu: Selection => Accept 

7 Save the selection. In exobasket menu: Selection => Save 

8 Choose the exobasket targets with time 
oversampling. 

In exobasket menu: Time oversampling => Select 
targets 

9 Choose the exobasket targets with colour 
photometry. 

In exobasket menu: Colour photometry => Select 
targets 

10 Print the exobasket content. In exobasket menu: Selection => Print 

11 Create the file for the proposed block. In exobasket menu: Selection => To HTML 

12 Display the Contamination Map. Overplots => Contamination map 
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STEP 3. COMMON FUNCTIONS 

Same functions as Step 2. 

Sub 
step 

Description Menu option 

1 Compute valid observations periods for 
each block (performed at the end of Step 
2). 

Observation => Edit => Status (set as Proposed) 

2 Check valid observations periods for each 
block. 

Planner => Observation periods 

3 Prepare the observations schedule using 
the observations periods. 

Planner => Schedule observations 

4 Calculate the pointing quaternion for each 
scheduled observation block. 

Planner => Schedule observations 

5 Calculate the pointing quaternion for a 
particular observation block. 

Planner => Line of sight 

6 Apply small corrections to observation 
blocks making them valid. 

In the main panel, Visual field section 

 

STEP 3. ASTEROSEISMOLOGY MODE 

Same functions as in Step 2 

Sub 
step 

Description Menu option 

7 Select the targets to observe for each 
block. 

In the main panel, extended star popup menu, 
Select star 

8 Define windows around selected targets 
according to mission and instrument 
constraints. 

In the main panel, extended star popup menu, 
Select star 

9 Select the SCAO couple for each block 
according to mission and instrument 
constraints. 

In the main panel, select the desired couple 

10 Create the file of selection targets for the 
proposed block. 

In the main panel, Create selection 
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STEP 3. PLANET SEARCH MODE 

Same functions as in Step 2 

Sub 
step 

Description Menu option 

11 Place up to 20 sub-images (or 
�imagettes�) over the desired targets for 
each block. 

In the main panel, Place button of the desired 
images list (i.e. the desired CCD) 

12 Create the file of targets for the proposed 
block. 

In the main panel, Create selection 

 


